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Release Notes

Integrated Dell Remote Access Controller 7 (iDRAC7)

IDRACY is a systems management hardware and software solution that provides remote management
capabilities, crashed system recovery, and power control functions for Dell PowerEdge systems.

Lifecycle Controller 2 Remote Services (LC2-RS)

LC2-RS provides advanced embedded systems management and is delivered as part of iDRAC7. LC2-RS
enables remote systems management in a one-to-many method. Remote Services uses WS-
Management (WS-MAN) protocol based Web services interface to remotely provision and manage the
servers.

Version
iDRAC7 1.50.50
LC21.3.0

Release Date
December 2013

Previous Version
iDRAC7 1.45.45
LC2115

Importance

RECOMMENDED: Dell recommends applying this update during your next scheduled update cycle. The
update contains feature enhancements or changes that will help keep your system software current and
compatible with other system modules (firmware, BIOS, drivers and software).

Platform(s) Affected

IDRACY and LC2-RS is supported on the following systems:

e PowerkEdge M520

e PowerkEdge M820

e Powerkdge R320

e Powerkdge T620

e PowerEdge M420

e PowerEdge R820

e PowerEdge T320

e PowerEdge R620

e PowerEdge M620

e Powerkdge R720

e Powerkdge R720xd
e Powerkdge R520

e Powerkdge R420

e PowerEdge T420

e DCS2210

e Compellent SC8000



What is Supported?
Supported Managed Server Operating Systems for iDRAC7

The following operating systems support iDRACY:
e Windows Server 2008 SP2 (32-bit)
e Windows Server 2008 SP2 (64-bit)
e Windows Server 2008 SP2 R2 (64-bit)
e Microsoft Server 2012 Essentials
e Microsoft Server 2012 R2
e Red Hat Enterprise Linux (RHEL) version 5.9
e Red Hat Enterprise Linux (RHEL) version 6.4
e Red Hat Enterprise Virtualization (RHEV) Hypervisor 5.9
e Red Hat Enterprise Virtualization (RHEV) Hypervisor 6.4
e SUSE Linux Enterprise Server (SLES) version 10 SP4 (64-bit)
e SUSE Linux Enterprise Server (SLES) version 11 SP2
e VvSphere version 5.0 U2
e VvSphere version 5.1 U2
e VvSphere version 5.5
e XenServer version 6.1

e XenServer version 6.2

Supported Web Browsers for iDRAC7

e Microsoft Internet Explorer 8
e Microsoft Internet Explorer 9
e Microsoft Internet Explorer 10
e Safariversion 5.2

e Safariversion 6.0

e Mozilla Firefox version 22

e Mozilla Firefox version 23

e Google Chrome version 27

e Google Chrome version 28

What's New

iDRAC7

The following are the new features in this release:
e Automatically configure components in a server or multiple servers using DHCP provisioning

e Update firmware from using firmware image file on a local system or on a network share, connecting to
the FTP site, or a network repository that contains a catalog of available updates.

e Schedule automatic firmware updates.
e Rollback firmware for all devices supported by Lifecycle Controller.
e Configure and schedule server configuration backups.

e Enabling or disabling HTTPs redirection.



e  Configure VNC Server to view remote desktop using mobile devices

e Configure LOM or USB NIC as the OS to iDRAC Pass-through channel

e Enable or disable I/O Optimization

e Enabling events to be logged into OS log

e Export the Lifecycle log entries to a network share or to the local system.

e Improved Virtual Media menu options:
o0 Connect or disconnect Virtual Media session from Virtual Media menu.
0 Specify the location of the image file that is created from the folder.
o0 Create an image from the folder without enabling Virtual Media session.
o New interface when Virtual Media is launched in standalone mode.

e Combined detailed Virtual Media performance statistic with Virtual Console statistic in Stats dialog

e Removed Remote File Share from First Boot device and Next Boot list

e Clear SEL logs.

e Display SEL logs in iDRAC Settings Utility.

e Recordlog in, log out, and log in failure events in the Lifecycle Controller logs.

e  Store certificate permanently in user's certificate store. Disabling Warming Messages While Launching
Virtual Console Or Virtual Media Using Java plug-in.

e Improved Remote File Share options.

e Use the iDRAC Service Module to perform monitoring functions similar to Server Administrator but in an
out-of-band environment.

e  Configure SNMP and SMTP ports
e Schedule automatic remote diagnostics
e Switch on or switch off the front panel LED from System Summary page
e Use wildcard certificates
e Use certificates signed by an intermediate CA
e  Generate Tech Support Report similar to Dell System E-support Tool report
e Display the following information for storage devices:
0 Sector size that the physical disks and virtual disks uses to store data.
Wear-out level or remaining life of the Solid State Drive (SSD) connected to a PERC.
T10 Protection Information (PI) capable drives supported by the controllers.
T10 PI capability for physical disks.
T10 PI capability is enabled or disabled for the virtual disk.
Controller boot mode support for controllers.
Enhanced auto import of foreign configuration is enabled or disabled for the controller.

O 0O 0O O o o o

Spans with different span length support for RAID 10 Virtual Disks.

iDRAC7 - Fixes

e [f common logging is enabled in iDRACY, CEM storage inventory takes more than 40 minutes. If
common logging is disabled (default setting), CEM storage inventory takes up to four minutes
for the maximum configuration.

e Launching Virtual console using Google Chrome browser, does not launch Java Web Start
automatically even after mapping launch application.

e On PowerEdge M420 blade servers, the iDRAC GUI's WWN/MAC page reports the Al and A2
network devices as reversed on systems in sub-slots b and d. A1 MAC addresses are reported in
the A2 section of the iDRAC Web interface, and A2 MAC addresses are reported in the Al section.
MAC addresses for systems in sub-slots a and ¢ are reported correctly.



e Drives that cannot be accessed may be displayed in the Virtual Media configuration menu when
using the Java plug-in. This occurs if inaccessible network shares or storage devices are
configured on the management station (for example, by the IT department).

e On 12th generation PowerEdge blade servers, in the iDRAC Web Interface, the WWN/MAC page
does not correctly report the chassis-assigned MAC addresses for the Intel i350 mezzanine card.
The secondary MAC for the B1/C1 device is reported as the primary MAC for B2/C2 device, and
vice versa.

e Inthe IDRACY Web interface, while viewing the CPU details under Overview -> Hardware, the
CPU status is displayed with a warming icon for a CPU that is absent and the status is blank.

iDRAC7 - Important Notes

e License Requirements:

— Software licensing has replaced hardware licensing. For more information, see, the Dell License
Manager User's Guide.

— Lifecycle Controller features such as Auto Discovery and vFlash are now licensed. Install the correct
licenses for Lifecycle Controller Remote Services to work properly.

e Only if there is one or more network interface cards (NDC or LOM) present on the managed
system, Network Devices appears under Overview -> Hardware section in the iDRAC7 Web
interface.

e When using iDRACY7 Web interface in Firefox 3.6 if the SD card is removed while partition
creation is in-progress, "The operation has been completed successfully” message is displayed.

e For the Virtual Console and Virtual Media to function properly, iDRAC7 Web URL must be added
to the Local Intranet site list and the security level for the Local Intranet zone should be set to
Medium-Low. In addition, if Virtual Console and Virtual Media are configured to use Java plug-in,
then disable the Enhanced Security Mode in Internet Explorer. If this is not possible, then in
IDRACY, configure Virtual Console to use the ActiveX plug-in.

e If the instant messenger is launched in the Virtual Console viewer with ActiveX native plug-in
and another application is started (example Notepad, WordPad, and so on) without minimizing
the Virtual Console, the instant messenger box also pops-up on other applications. This does
not happen with Java plug-in.

e When a system is in POST, it is not possible to attach a vFlash partition as the first boot device.

e Virtual Console Viewer from iIDRACY7 Web interface terminates when the managed system is
restarted.

e A pop-up message is not displayed to confirm if test emails are successfully sent or not.

e For iDRACY Enterprise, when the Virtual Console is disabled and Virtual Media is disabled and/or
detached, the console port (default: 5900) remains open. For iDRAC7 Express (no Virtual Console
or Virtual Media) the console port is open.

e If auto-negotiation is enabled while setting iIDRACY network, 1 Gbps is not supported and you
cannot manually select it.

e A USB device mounted through Virtual Media in floppy emulation mode for a Linux operating
system shows as a removable volume.

e During system power operations, if the video mode changes, the message "Out of range” may
appear for a short while on the Virtual Console.

e When using the Virtual Console in native console mode with "Pass all keystrokes to server”
disabled in Internet Explorer versions 8 and 9, if an F1/F2 prompt is encountered, pressing F1
displays the Virtual Console online help pop-up in addition to continuing with the system boot.

e When any of the storage enclosure components are removed, the corresponding details are not
displayed. Only the name and status attributes are displayed.

e When certain RAID operations are requested using WS-MAN on non-RAID cards such as, the
Dell SAS 6Gbs HBA or the Internal Tape Adapter, the operation succeeds, however the job fails
with the error message "Unable to locate device in current configuration”.



If the iDRACY network is configured to use a shared LOM and the spanning tree is enabled on
the LOM port, WS-MAN and remote service commands may time-out in the following scenarios:

— At system reboot
— When CSIOR is running
— While entering SSM
The connectivity lost is variable. In typical cases, it is approximately:

— 40 seconds at system reboot and varies per NIC or link speed
— 20 seconds when CSIOR is running
— 40-60 seconds while entering SSM

The reason is that when spanning tree is enabled, the switch does not allow the link to re-establish the
connection after a reset until it completes checking for network loops. Server reboots reset the NIC and
disconnects the link.

Note: This does not occur while using dedicated NIC because server reboots do not affect the dedicated
NIC.

When logging in to iDRACY Web Interface using Intermet Explorer 9 and IPV6 address, the
connection may not succeed. To resolve this, make sure that in Internet Explorer -> Tools ->
Internet Options -> Connections -> LAN Settings, the Use automatic configuration script
option is cleared.

On PowerEdge systems with cabled power supply units installed (that is, PSUs which do not
provide PMBus support), power values may still be displayed in the iDRAC7 web and LCD
interfaces. Due to lack of PMBus support in the PSUs, the power values displayed on the GUI
pages, including the Overview -> Hardware -> Front Panel page, are not correct.

Due to the independent nature of the alert processes (e-mail, SMTP, remote syslog), when
changing the licenses that affect alert features (example, email alerts for Express or remote
syslog for Enterprise) there is no guarantee of the timing of the features being activated or
deactivated when the license changes.

In the iDRAC Web interface, when the System Inventory page is accessed for the first time, it
takes up to two minutes for the inventory data to be collected. After the data collection is
complete, refresh the page to display the inventory data.

Make sure to synchronize the iDRAC time with the management station's time to avoid
certificate related issues. If the time is not synchronized, issues such as server certificate
expiration may be seen. If this occurs, re-synchronize iDRAC time with the management
station'’s time and reboot iIDRAC.

On a Linux system, after launching the Virtual Console, if you click on a menu item and it
remains open, the Ctrl + Alt + L keystroke sent from the iDRAC to the host system does not lock
the host system. The behavior is the same as using a local keyboard.

The default time zone value is US Central Time. To make sure Single Sign-On (SSO) and
Directory Service TFA (smart card) continue to work properly, the iDRAC time zone must match
the time zone where iDRAC is located, assuming Active Directory server's time zone is already
configured to match the Active Directory’s location. For example, if Active Directory server is
located at US Eastern time zone and iDRAC is located at US Pacific time zone, Active Directory
server has to be configured as US Eastern time zone (this is Active Directory server configuration
and is normally configured), and iDRAC must be configured as US Pacific time zone.

For more information to configure the time zone, see the iDRACY User's Guide.

If the management station is using MAC operating system, it takes more time to launch the
Virtual Console due to the following DNS search issue:
http://www.eigenspace.org/2011/07/fixing-osx-lion-dns-search-domains/

For iDRACY 1.30.30 or later versions, if the iDRAC is configured using the Import Configuration
XML operation, "user password is changed” messages are logged in the Lifecycle Log. An LC Log
entry is generated and the default settings are applied for all local user accounts that are not
configured through the XML configuration file.

The help page for the Export and Import of Server Profile feature does not provide the correct
share name. See the Web Services Interface Guide available at www.dell. com/support/manuals
for the correct share name.



e Remote Sys Log settings take effect only if you do the following:
— Enable remote syslog feature
— Specify the server address and port number
— Enable Remote SysLog option on the Alerts page

e  When IVYBRIDGE CPU is installed on PowerEdge R720, R720xD, R620, T620, or M620 systems,
the iDRACY firmware update from 1.45.45 to an earlier version is not allowed (example, from
14545 t01.40.40 or to 1.37.35, and so on).

e After an IDRACY firmware update, a few of the iDRAC7 Web interface panels or navigation menu
items may contain incorrect or invalid entries. To resolve this, clear the browser cache(s) after
updating the iDRACY firmware.

e When creating a Virtual Media image from a folder, the output image file size is at least 512 MB.

e Tolaunch Virtual Console using Java plug-in, only JavaWebStart versions 1.5, 1.6, and 1.7 from
Sun (Oracle) is supported. Any other versions or any other installations are not supported.

e On a server running RHEL operating system, performing the following steps can create a
eth*.bak interface (where * is the interface number). This is visible in the Network Manger
interface. This interface can be safely ignored.

1. After the operating system (RHEL) is running, enable OS to iDRAC Pass-through channel
through the iDRAC Web interface.

2. Disable OS to iDRAC Pass-through.

3. Reboot or power cycle the server, and then re-enable OS to iDRAC Pass-through.

iDRAC7 - Known Issues

Issue 1

Description

[n Chinese locale on Windows operating system, while launching the Virtual Console using Java plug-in,
occasionally you may see a Java compilation error.

Resolution

1. Open the Java control panel.

2. Go to General -> Network Settings.

3. Select Direct Connection and click OK.
Versions/Systems Affected

All iDRAC7Y supported Dell PowerEdge systems.

Issue 2:

Description
Known iDRAC7 IPv6 limitations:
o0 Email alerts are not sent if the iDRAC7 DNS Domain Name is not specified when using IPv6.

o0 Network File Share (NFS) mounting does not work with IPv6. This applies to features such as
connecting a remote file share or exporting the Lifecycle Controller log to a network shared
location.

o0 Firefox versions 4.x, 6.x, and 7.x may prevent the iDRAC7 Web interface from opening when
using IPv6. For more information see: https://bugzilla.mozilla.org/show_bug.cgi?id=633001

o0 On Microsoft Windows Operating Systems, when launching Virtual Console using Java plug-in
or when launching Video Capture plug-in, empty warning dialogs may appear. Continue to click
OK to launch the plug-in. This is a known limitation in Java Web Start if it's Network Settings is
set to use browser settings. To resolve this, set the Java's Network Settings to Direct Connection.



Resolution (only for logging in to iDRAC7 Web interface):

1. Register iDRACY to DNS.

2. Make sure the client system also has this DNS in its DNS list.

3. Enable [Pv6 and disable [Pv4.

4. Log in to iIDRACY using the Fully Qualified Domain Name (FQDN).

For launching Virtual Console with [Pv6 in Firefox 4.0 or later versions, from Windows management
system, run ipconfig /flushdns in the command prompt.

Versions/Systems Affected
All iDRACY supported Dell PowerEdge systems.

Issue 3:

Description
The Learn More pop-up on the License page does not appear using IE.
Resolution

Add *.dell.com to the trusted sites in the Security settings. See the /nternet Explorer help documentation
for more information.

Versions/Systems Affected
AlLIDRACY supported Dell PowerEdge systems.

Issue 4:

Description

On Windows operating system, to add a folder as an image using the Virtual Media, the Desktop
directory must be in the HOMEPATH directory. The HOMEPATH directory may vary depending on the
Windows installation, but the images created from the "Add Folder as Image” operation always reside in
the %HOMEDR IVE%\%HOMEPATH%\Desktop directory. The HOMEDRIVE must be set to C drive. Otherwise,
the operation fails.

Versions/Systems Affected
All iDRACY supported Dell PowerEdge systems.

Issue 5:

Description

[f the management station is using Linux operating system with the Pass all keystrokes to server option
enabled, you cannot resize the Virtual Console viewer window by dragging the corners or frame. This is
a limitation of X-Windows.

Resolution:
Do any of the following:
o0 Disable the Pass all keystrokes to server option.

o0 With Pass all keystrokes to server option enabled, open any menu in the Virtual Console viewer
window title bar, then re-size the window.

Versions/Systems Affected
AlLIDRACY supported Dell PowerEdge systems.

Issue 6:

Description
vFlash functionality remains enabled after firmware update without preserving configuration.

If vFlash functionality is enabled and a firmware update is performed without preserving the
configuration (Preserve Configuration is not selected), the vFlash Enabled option remains selected.
This is a known behavior.



Resolution

You must manually enable or disable the vFlash functionality after the firmware update as required. To
do this, select or clear the vFlash Enabled option in the iDRAC7 Web interface, or use RACADM or
WinRM remote service commands.

Versions/Systems Affected
AlLIDRACY supported Dell PowerEdge(TM) systems.

Issue 7:

Description

In some scenarios, typically for state change events occurring within a span of few seconds, the
sequence of events reported in the Lifecycle Log (or corresponding SNMP traps/email alerts) for storage
devices may not exactly match the sequence in which they occurred.

Resolution

The current state or attribute of the storage device can be checked in any of the iIDRACY interfaces
(example, iDRAC7 Web interface, RACADM and so on).

Versions/Systems Affected
All Dell PowerEdge systems with iDRAC7 and out-of-band enabled PERC storage controllers.

Issue 8:

Description

When enclosures connected in the redundant path are re-wired (connections are switched) to result in a
non-redundant path, the reported connected port value of the enclosures may not be accurate.

Resolution

Power cycle the server.

Versions/Systems Affected

All Dell PowerEdge systems with iDRAC7 and out-of-band enabled PERC storage controllers.

Issue 9:

Description

When a storage enclosure is disconnected or accidentally removed, the corresponding status of its
components (that is, EMM, PSU, fan, and temperature sensors) is reported as critical.

Resolution

If the storage enclosure is disconnected accidentally, reconnect it to get back to normal state. If it is
intentional, perform iIDRACY reboot or server power cycle to remove the enclosure entries from the
consoles.

Versions/Systems Affected
All Dell PowerEdge systems with iDRAC7 and out-of-band enabled PERC storage controllers.

Issue 10:

Description

Logging in to iDRACY Web interface fails with the error message 'RAC0218: The maximum number of
user sessions is reached’.

When the temporary folder used by iDRAC7 components is full, it is possible that authentication fails and
this error is displayed.

Resolution

Power cycle iIDRACY to clear the temporary space.



Versions/Systems Affected
All Dell PowerEdge systems with iDRACY.

Issue 11:

Description

On Microsoft Windows? operating system, while launching Virtual Console in native mode using
Internet Explorer, the iDRAC7 Login page is displayed.

Virtual Console uses plug-ins and due to insufficient privileges plug-in does not load and iDRAC7 Login
page is displayed.

Resolution

Reboot operating system and log in to iDRAC7 Web interface.
Versions/Systems Affected

All Dell PowerEdge systems with iDRACY.

Issue 12:

Description

When selecting browser buttons (forward or back), the GUI pages are not displayed correctly and
sometimes the same page re-appears.

IDRACY Web interface is a platform management application and all the necessary controls are provided
within the application. The Web browser buttons are outside of this application and may not function

properly.

Resolution

Use the navigation options within the iDRAC7 Web interface.
Versions/Systems Affected

All Dell PowerEdge systems with iDRACY.

Issue 13:

Description

When you log in to iDRAC7 Web interface using Internet Explorer 9.x, contents in few pages are not
shown properly. This is a known issue with Internet Explorer.

Resolution

1. Press <F12>. The Internet Explorer 9 Debug window is displayed.

2. Select Document Mode -> Internet Explorer 7. The browser refreshes and the iDRAC7 Login page is
displayed.

3. Close the Internet Explorer 9 Debug window.

4. Close all open Internet Explorer windows.

5. Open Intemet Explorer and log in to iDRACY7.

For more information, see Internet Explorer documentation.
Versions/Systems Affected
All Dell PowerEdge systems with iDRACY.

Issue 14:

Description
When an Enterprise or Enterprise Evaluation license expires, Active Directory is disabled automatically.
Resolution

After re-installing the Enterprise or Enterprise Evaluation license, an administrative user can log in as an
existing local iDRACY user to re-enable Active Directory authentication, using any iDRACY interface such



as RACADM or the Web interface. Remote RACADM can be used in a script to batch-enable Active
Directory. If a local iDRACY user is not enabled or is not configured for remote access, the administrative
user must use local RACADM or OpenManage Server Administrator to configure a local user.

Versions/Systems Affected
All Dell PowerEdge systems with iDRACY.

Issue 15:

Description

When a power reset is performed, the Virtual Console Viewer menu options (except File -> Exit and
Help options) are grayed-out or inaccessible. The 'Link interrupted’ message appears at the bottom of
Virtual Console Viewer.

Resolution

Due to a temporary network outage, the Virtual Console Viewer menu options are not accessible. The
"Link interrupted” message is displayed to indicate that an outage has occurred. This is a temporary
problem and the menu options are available when the network is restored.

Versions/Systems Affected
All Dell PowerEdge systems with iDRACY.

Issue 16:

Description

IDRACY Web interface does not respond when using Intemet Explorer.

Resolution

Close all Internet Explorer sessions and open it again to access iDRAC7 Web interface.
Versions/Systems Affected

All Dell PowerEdge systems with iDRACY.

Issue 17:

Description

When a driver pack DUP update is performed, the following message is recorded in the Lifecycle log after
the driver pack update entry.

RAC0400: iDRAC memory low 1IDRAC is running low on memory. System performance may be degraded.
Recommended Action: No response action is required.
Resolution

No workaround is required. This is a normal condition when the memory is lower than the threshold for
around 30 seconds and returns to normal after the driver pack update finishes.

Versions/Systems Affected
All Dell PowerEdge systems with iDRACY.

Issue 18:

Description

Resetting iDRACY to default values action may take between four to six minutes to complete.
Resolution:

Wait for iDRAC7Y to reboot before performing any other action.

Versions/Systems Affected

All Dell PowerEdge systems with iDRACY.



Issue 19:

Description

In the iDRACY Web interface -> Overview -> Server -> Power/Thermal -> Power Monitoring tab ->
Power section, the Power Unit selector only changes the unit of measure. Due to the oscillating nature
of power, the Present Reading cannot be displayed as units for Current (Amps).

Resolution

None.

Versions/Systems Affected

All Dell PowerEdge systems with iDRACY.

Issue 20:

Description

On all Intel NICs, each port cannot be assigned different iSCSI initiator name (by assigning the value for
[scsilnitiatorName). If the name is changed for one port, the same change is applied to all ports.

Resolution

None.

Versions/Systems Affected

All Dell PowerEdge systems with iDRACY.

Issue 21:

Description

When virtual world wide name and virtual world wide port name attributes on a NIC partition are set
using the WS-MAN interface, the new values are not updated in the iDRAC7 Web interface or when
racadm getsysinfo is run

Resolution

Use WS-MAN interface to obtain the updated values for those attributes.
Versions/Systems Affected

All Dell PowerEdge systems with iDRACY.

Issue 22:

Description

The Predicted Capacity Status attribute of the storage controller battery reported by iDRACY interfaces
may not be accurate in some situations.

Resolution

The Predicted Capacity Status attribute has been deprecated. To view the correct battery state, use the
storage battery state/status values instead.

Versions/Systems Affected
All Dell PowerEdge systems with iDRAC7 and out-of-band enabled PERC storage controllers.

Issue 23:

Description

When inventory changes are done to the storage sub-system (such as inserting and removing disk drives,
and so on) before or during POST/reboot, the corresponding events may not be recorded in Lifecycle log.
SNMP traps/email alerts may not be generated and the inventory changes may not be correctly reflected
in the iDRACY interfaces (example, iDRAC7 Web interface, RACADM and so on).

Resolution

To view the correct storage inventory data, perform a server power cycle (cold boot).



Versions/Systems Affected
All Dell PowerEdge systems with iDRACY and out-of-band enabled PERC storage controllers.

Issue 24:

Description

[f a NIC card, with partitioning enabled, is replaced with a similar type of card, without partitioning
enabled, the configurations from the previous card are not applied to the new card.

Resolution:

After the previous card is replaced with a new card and the system is powered on, go to OptionROM
(CTRL-R) and enable partitioning. Save, exit, and reboot the system.

Versions/Systems Affected
All Dell PowerEdge systems with iDRACY.

Issue 25:

Description

When using DownloadServerPublicKey or DownloadClientCerts commands in WSMAN, the invocation
may fail when the iDRACY system is not ready to service the operations. This may happen when host
system is in a POST stage.

Resolution

Wait until host system is past the POST stage and retry the command.
Versions/Systems Affected

All Dell PowerEdge systems with iDRACY.

Issue 26:

Description

When launching Virtual Console viewer using ActiveX plug-in, a blank window appears and Virtual
Console viewer does not launch.

Resolution

This may be due to incompatible binaries from a previous version. Remove temporary files from the
download location on your system (for example, C:\windows\Downloaded Program Files) and retry.

Versions/Systems Affected
All Dell PowerEdge systems with iDRACY.

Issue 27:

Description

When video player is launched, it launches both a playback control window and a playback window. On
a Linux RHEL6.0 workstation, if the playback window loses focus, then you cannot switch back using the
mouse.

Resolution:

This is an issue with the RHEL 6.0 version of Linux. Close the playback control window by selecting 'x’
and select the playback program on task bar using the mouse to display the playback window. If you
need to view the playback controls again, select its menu item from the playback window.

Versions/Systems Affected
All Dell PowerEdge systems with iDRACY.



Issue 28:

Description:

When running the Virtual Media client on Windows 7 or Windows Server 2008 R2, the Virtual Media
client may not be able to access a floppy disk in read-write mode because of a problem with the client
workstation operating system.

Resolution:

Apply the operating system update to the Windows 7 or Windows Server 2008 R2 client workstation
operating system as specified in the following link: http://support.microsoft.com/kb/2496290.

Versions/Systems Affected

All iDRACY supported Dell PowerEdge systems being accessed by a Windows 7 or Windows Server 2008
R2 client workstation without the specified update applied.

Issue 29:

Description:

There is no option to eject the USB drive on SUSE Linux Enterprise Server 11. The only option to unmap
virtual USB is to force unmapping using the Virtual Media window.

Resolution:

Unmount virtual USB before forced unmapping to make sure the server has completed all the pending
tasks before the drive is unmapped.

Versions/Systems Affected
AILIDRACY supported Dell PowerEdge systems.

Issue 30:

Description:

Learn More option in the Licensing page does not work on Safari browser.
Resolution:

Disable the popup blocker for Safari browser.

Versions/Systems Affected

AlLIDRACY supported Dell PowerEdge systems.

Issue 31:

Description:

In a Linux operating system, after logging in to the iIDRAC Web interface using a Firefox browser and you
launch the Virtual Console, sometimes Virtual Console window does not respond to keyboard input.

Resolution:

Close and re-launch the Virtual Console.
Versions/Systems Affected

AlLIDRACY supported Dell PowerEdge systems.

Issue 32:

Description:

When there is no license installed on a value line platform like T420, you cannot perform any firmware
update through iIDRAC Web interface using Dell Update Packages (DUPs). This is the correct behavior,
but the displayed error message is not correct. Error message is "LIC006: The License has expired. Obtain
a replacement license and import it.”



Resolution:

Obtain an appropriate license then try again. If the problem persists, contact the technical support. See
the product documentation to choose the contact method that is convenient for you.

Versions/Systems Affected.:
All Dell PowerEdge systems with iDRACY.

Issue 33:

Description:

[f you try to upload any other certificate other than a valid PKCS#12 format file, the iIDRAC Web interface
displays an incorrect error message.

Resolution:

Upload a valid PKCS#12 format certificate file.
Versions/Systems Affected.:

All Dell PowerEdge systems with iDRACY.

Issue 34:

Description:

On applying Delete Custom SSL Certificate when no certificate (CSC) is available, GUI displays the
message: RAC0507 Unable to find the requested resource. Do one of the following and retry the
operation:

0 Turn on the system.
o0 Make the resource available.
Resolution:
No impact as such, the request to delete non-existent CSC results in this message.
Versions/Systems Affected.:
All Dell PowerEdge systems with iDRACY.

Issue 35:

Description:

After uploading a custom signing certificate to iDRAC and restarting iIDRAC, when you log in to iDRAC
Web interface using Firefox browser, the security certificate error is displayed. This is because the serial
number of the certificate that was stored in the Firefox browser cache is the same as the serial number
of the certificate on iIDRAC.

Resolution:

Remove the browser certificate in the cache and log in to the iDRAC Web interface. For information on
removing certificates, see the Firefox documentation. If the problem persists:

1. Log in to iDRAC using racadm and run sslresetcfg.
2. Perform steps to upload custom signing certificate.

Issue 36:

Description

On PowerEdge M520, if a Broadcom 57810S DP 10G KR Mezz 55 GHP or Qlogic DP 10 Gb SFP+/DA CNA
Mezz RX8GJ is installed, an additional blank entry is displayed in the System Inventory page of the Web
interface and on other interfaces such as RACADM, WSMAN, and Lifecycle Controller GUL

Resolution
This is a false entry and can be ignored.



Versions/Systems Affected
Dell PowerkEdge M520

Issue 37:

Description

Sometimes invalid characters are displayed on the server console screen after exiting iDRAC Virtual
Console.

Resolution

Launch virtual console and clear the Automatic System Lock option.
Versions/Systems Affected

All Dell PowerEdge systems with iDRACY.

Issue 38:

After an iIDRACY firmware update, some of the iDRACY Web interface panels or navigation menu items
may contain incorrect or invalid entries.

Resolution

Clear your browser cache(s) after updating the iDRACY firmware.

Versions/Systems Affected

All Dell PowerEdge systems with iDRACY.

Issue 39:

Description

Credential vault contents may be erased when upgrading to or downgrading from iDRAC7 firmware
version 1.40.40, resulting in different symptoms.

Resolution

Back up the Credential Vault data (uploaded certificates, and so on) before upgrading to or downgrading
from IDRAC7 1.40.40 firmware. After the firmware update is complete, reload the Credential Vault
contents.

Versions/Systems Affected
All Dell PowerEdge systems with iDRACY.

Issue 40:

Description

In the IDRAC7 Web interface > System Inventory page, the AMULET Video Mezzanine card description is
displayed as "Whistler[Radeon E6760]" and the description for Manufacturer is displayed as "Advanced
Micro Devices[AMD]nee ATT".

Resolution

No impact and can be ignored.

Versions/Systems Affected

PowerEdge M420, PowerEdge M520, and PowerEdge M620 systems with iDRAC7.

Issue 41:

Description

When the host operating system is Windows Server 2012 Re, if the Virtual Media device is mapped to the
host system and if you try to perform firmware update to an earlier version using Dell Update Package
(DUP), the firmware update process may stop.

Resolution



If you want to update the firmware to an earlier version (example, from 1.45.45 to 1.40.40 or to 1.37.35,
and so on), use the iDRAC7 Web interface instead of a DUP package. If you have to use a DUP, then
before running the DUP, make sure there are no active Virtual Media sessions on iDRAC.

Versions/Systems Affected:
All 12th generation Dell PowerEdge servers with Windows Server 2012 R2 operating system.

Issue 42:

Description

When performing firmware update using local racadm with —pud option (update from the host server), if
racadm is not invoked from the installation directory (example, C:\Program Files\Dell\Sysmgt\iDRAC)),
then after the firmware update is completed successfully, the following error message may be displayed:

"Waiting iDRAC Fully Initialized Timeout”
Resolution

Run local racadm from the racadm installation directory.

Issue 43:

Description

In the IDRAC7 Web interface, the System Inventory or Network Device page for Fibre Channel devices
does not display the current firmware version or vendor name details for Emulex FC16 card.

Resolution

Update the FC16 firmware twice from the operating system (not using the iDRAC update method). For
more information, see Emulex documentation.

Versions/Systems Affected
All Dell PowerEdge systems with iDRACY.

Issue 44:

Description

In systems with iDRAC 1.30.30 firmware version, the sslencryptionstrength racadm command does
not work for both firmware and local racadm interfaces.

Resolution

Use the remote racadm interface, IDRAC Web interface, or WSMAN to configure the SSL encryption
length. You can also use idrac.webserver.LowerEncryptionBitLength object.

Versions/Systems Affected
All 12th generation Dell PowerEdge servers with iDRACY version 1.30.30.

Issue 45:

Description

After exiting virtual console from iDRAC sometimes invalid characters appear on the server screen when
is there is no desktop running on the server operating system.

Resolution

Launch Virtual Console and clear the Automatic System Lock option.
Versions/Systems Affected

AlLIDRACY supported Dell PowerEdge systems.



Issue 46:

Description

Full export of Lifecycle Controller logs in Mac OS through Safari browser generates Log.xml file instead
of Log.xml.gz file and the Log.xml contains partial content.

Resolution

1. Open Safari in Mac.
2. Goto Safari > Preferences > General.
3. Clear the Open 'safe’ files after downloading option.

Versions/Systems Affected
All iDRAC7Y supported Dell PowerEdge systems.

Issue 47:

Description

In some scenarios, typically when a PCle SSD is removed from a server slot and a different PCle SSD is
inserted within a span of 5-10 seconds into the same slot, the server fan speeds may not get optimally
configured to accommodate the thermal profile or tier of the inserted PCle SSD.

Resolution

Power cycle the server.

Versions/Systems Affected

All Dell PowerEdge systems with iDRAC7 and PCle SSDs.

Issue 48:

Description

On servers with Windows 2008 SP2 64-bit operating system, the IDRAC Virtual NIC USB Device is not
discovered automatically (or enabled). The iDRAC Virtual NIC USB Device appears under unknown
devices with yellow bang (or warning symbol).

Resolution

See steps recommended by Microsoft to manually update the RNDIS driver for this device.
Versions/Systems Affected

All Dell PowerEdge Systems with iDRAC7.

Issue 49:

Description

If the system with Linux operating system is stand alone or connected to a network hub, the
communication to iDRAC through the OS to iDRAC pass-through channel for LOM pass-through mode
does not work in the following scenarios:

1. For systems shipped from factory, initially the iDRAC network is in dedicated mode and the OS to iDRAC
pass-through feature for LOM pass-through mode is disabled. The network cable is installed at LAN1. The
host and the iIDRAC IPs are configured for static IP addresses in the same subnet. Switch the iDRAC
network from dedicated to shared mode, enable OS to iIDRAC pass-through and set the pass-through
mode to LOM.

2. When LANL1 is connected to a switch:

a. Both iDRAC and the host [Ps are configured for static IP addresses in the same subnet.

b. Either iDRAC or the host IP is configured for static IP address and the other one
received the IP through DHCP.

c. 1DRAC and host both receive the IP through DHCP.



Resolution
To enable OS to IDRAC pass-through in shared mode:

1. Set the static IP address on the host system using the Network Manger GUI or edit the
/etc/sysconfig/network-scripts/ifcfg-ethO file.

2. Set the static IP address for the iDRAC in the same subnet

3. Enable OS to IDRAC pass-through feature. For the steps, see iIDRACY User's Guide at
www.dell.com/esmmanuals.

4. Reboot the host system.

5. After restarting the host system, connect to the iDRAC using the static iDRAC IP address.

Versions/Systems Affected
All Dell PowerEdge Systems with iDRACY.

Issue 50:

Description
When logging into iDRAC console, occasionally log in fails with PKCS security error.
Resolution

Run the racadm sslresetcfg command to clear this issue and log in successfully. This installs the
default certificates and any self-signed or customer SSL certificates are replaced with the default
certificate.

Versions/Systems Affected
All Dell PowerEdge Systems with iDRACY.

Issue 51:

Description

When the operating system language is English and in Internet Explorer, if you change the browser's
language settings to a localized language, and then launch the iDRACY IP, the pages are displayed in
English instead of the selected language. However, if it is the language specific operating system, the
pages are displayed in the localized language.

Resolution

Use Firefox browser to display the pages as per the language specified in the language settings.
Versions/Systems Affected

All Dell PowerEdge Systems with iDRAC7 1.50.50.



iDRACY7 - Limitations

e If floppy emulation is enabled when a bootable USB key is mounted as a Virtual Media from the
Virtual Console and if you try to delete any file from the mounted USB key (floppy), the blue
screen appears immediately.

e Web server session time-out is not exact. It is either 10% more or 15 seconds more, whichever is
greater.

e  WiIinRM and RACADM commands may become unresponsive during BIOS update or when
setting BIOS, NIC, or RAID attributes through Lifecycle Controller.

e Ifinvalid credentials are used for the maximum login attempts, the IP is blocked for the duration
of the IP Blocking Penalty Time and a message is not displayed.

e If Internet Explorer (IE) 64-bit browser is used to log in to iDRAC7 Web interface and when
viewing the power usage graph, the X and Y axis labels appear too small to read. This is a known
limitation for IE 64-bit only.

e The labels appear correctly in IE 32-bit browser.

e On Linux management stations, if Firefox is launched from the root user, a USB key is mapped in
Virtual Media successfully. If Firefox is launched from any user other than the root user, a USB
key is not shown for mapping because the user must have root privileges to access all the low-
level drives.

e Alert notification for battery events does not work.

e Operating system information on the System Summary page does not display after rebooting
IDRACY until the operating system is rebooted.

e iDRACTY users with user names containing a semi-colon (;) cannot log in to iDRAC7 through SSH.

e In the IDRACY Web interface, the power consumption sensor reading may have a rounding error
of up to 13 Watts depending on the actual power reading. This is an IPMI limitation. The power
cap, power graphs, cumulative power, and peak power are not affected by this inaccuracy.
However, the power values shown in the power graphs are average values over a period of time
and should not be used to calculate instantaneous power.

e Virtual Console uses self-signed certificates. Due to this, when launching Virtual Console from
some management stations with Windows operating systems, a certificate warning appears.

e Virtual Console in dual monitor mode is not supported and hence the behavior is undefined,
especially using Java plug-in. The primary console is used as the target console.

e The e-mail address specified in iDRAC7 Web interface -> Overview -> iDRAC Settings ->
Network -> SSL -> Generate Certificate Signing Request (CSR) page is not validated.

e On a Linux management station with Matrox drivers, from the Virtual Console Viewer if you
access the iDRAC Chat window, the mouse appears flickering inside the chat window.

e Work notes can display up to 255 characters. If any of the characters are special characters or
non-alpha numeric characters, then the total number of characters displayed is less than 255 to
accommodate overriding special characters.

e Performing a graceful shutdown from the iDRAC7 Web interface or updating the BIOS or the
firmware using the iDRAC7 update method:

e For SLES 11 SP2:
A prompt appears for the Super user password in the operating system console. Provide the root
password and proceed with the graceful shutdown or firmware/BIOS update.

e For Windows OS in screen lock state:
Graceful shutdown does not happen because, Windows operating system has a policy setting to
disable shutdown while in locked state. Make sure that this policy is enabled.
If it is not enabled, then it proceeds with ungraceful shutdown. This is equivalent to losing
power. After the server resets, multiple options are displayed to start Windows. Select Start
Windows Normally and then check the System Event Log file. You can see that an event is
logged in for the ungraceful shutdown.

e Performing a graceful shutdown from the iDRAC7 Web interface or updating the BIOS or the
frmware using the iDRAC7Y update method:



— For SLES 11 SP2:
A prompt appears for the Super user password in the operating system console. Provide the root
password and proceed with the graceful shutdown or firmware/BIOS update.

— For Windows OS in screen lock state:
Graceful shutdown does not happen because, Windows operating system has a policy setting to
disable shutdown while in locked state. Make sure that this policy is enabled.
If it is not enabled, then it proceeds with ungraceful shutdown. This is equivalent to losing power.
After the server resets, multiple options are displayed to start Windows. Select Start Windows
Normally and then check the System Event Log file. You can see that an event is logged in for the
ungraceful shutdown.

e Inthe IDRAC Web interface > Overview > Server > Lifecycle Log page, when the filter criteria
results in nothing found, the Log Results section does not display any user-friendly information
and it is blank instead.

e VNC disconnects after host reboot on Wyse PocketCloud,
e Encrypted VNC does not work through Real VNC client.
e VNC does not work through mobile when encryption is enabled.

e OS to IDRAC communication through the USB NIC interface is not supported on RHEV — H
(hypervisor) system.

e OS to iDRAC pass-through feature does not work when the host operating system is Linux.

e {DRAC Virtual NIC driver is not loaded when Windows 2008 SP2 (64 bit) installation has
completed.

e When Virtual Console is in Lifecycle Controller, if Next Boot is set to BIOS Setup, rebooting the
system boots to Lifecycle Controller instead of BIOS Setup.

LC2-RS - Fixes

BITS104701: PCle SSD configuration should be blocked through Remote Services

LC2-RS - Important Notes

If the iIDRACY version is 1.50.50, Lifecycle Controller version must to be updated to 1.3.0.x.

LC2-RS - Known Issues

Issue 1:

Description

Lifecycle Controller may not perform the required operation correctly if incompatible iDRAC firmware is
used.

Resolution

Update the Lifecycle Controller version to 1.3.0.x if the iDRACY version is 1.50.50.
Versions/Systems Affected

All LC2-RS supported Dell PowerEdge systems.



LC2-RS - Limitations

e The drivers exposed by Lifecycle Controller are present in a read-only device labeled OEMDRY,
and the device is active for 18 hours. In a Microsoft(r) Windows(r) and Linux environment, the
drivers are automatically installed and no further action is required. In Red Hat Enterprise Linux
version 4.8 only, the drivers are not automatically installed and you have to install the drivers
manually after the OS installation has been completed.

e If the boot mode is set to UEFI in BIOS (F2 setup) and if you launch System Services (FIO) and
Deploy OS, the installation may fail or you may not be able to boot to the OS after the
installation. Always make sure that the boot mode is set to BIOS in F2 setup before launching
Lifecycle Controller and deploying the OS.

e You may see a no optical device found error if you have a non-usable DVD/CD in the optical
drive. This error does not mean that there are no optical devices on the system. If you remove
the non-usable media, then this error is resolved.

e To maintain compatibility with other iDRAC configuration tools, it is recommended that only
digits (0-9), alphanumeric (a-z, A-Z) and hyphen (-) characters be used when entering a "Name”
or "Password” string. When entering a "Domain Name”, such as 'x123.com’, a period (.) character
s also permissible.

e When attempting a Platform Update through an FTP server, specifying a valid proxy server but
selecting an invalid proxy type causes Lifecycle Controller to halt for a long period (possibly over
30 minutes) before it returns to normal operation.

e If you see this error message "Unable to find a boot device on which to install the operating
system. Verify boot disk availability.” and if you have a USB key plugged in to the system after
booting to Lifecycle Controller, remove the USB key before deploying the operating system.

e If you are updating iDRAC firmware using a tool other than Lifecycle Controller, do not run
Lifecycle Controller during the firmware update because doing this result in unknown behavior.
After the firmware is successfully updated, you can safely use Lifecycle Controller.

e When configuring the FTP server for your repository in the platform update, you may get a
message that indicates that a network connection exists with your FTP server; however, it may
mean that the validation process needs some extra time depending on your network setting.
Click OK on the message box, and try one more time to connect to the FTP server.

e Account access can be disabled only if there is more than one user enabled on the iDRAC. To
enable users, access the iDRAC Web-based GUI. Navigate to the Users section under the
Network/Security tab and enable users as needed. Note that at least one more user needs to be
enabled to disable the account access in the Lifecycle Controller. In the iDRAC Configuration
Wizard, the DNS Domain Name may contain a maximum of 64 ASCII characters.

e When attempting a Platform Rollback, there may be a two minute delay before Rollback tasks
are displayed on the screen.

e Inthe iIDRAC Configuration Wizard, there is no a selection for auto-attached on the Virtual
Media Configuration page.

e During an UEFI based SLES 10 and SLES 11 installation, make sure that no additional USB or block
storage devices are connected to the system. If there are one or more USB or block storage
devices plugged into the system, the auto loading of drivers from the embedded storage fails.
This fails because the current implementation of SLES installer reads only from one USB or block
storage device.

e If an invalid SD card is attached to the system, the values shown for "Health” and "Available
Space” options are not applicable.

e An ’Invalid Update Package” error message is displayed, when
— the folder containing the Update Package is not accessible.
— the Update Package is not present on the USB mass storage device.
— name of the Update Package is incorrect.
e Only Windows operating system can be deployed on systems with software RAID controller.

e Using Platform Update, you cannot update components such as Complex Programmable Logic
Device, Backplane, and Physical Disk. However, the View Current Versions table displays these
components.



e The SATA drives and their firmware version are not displayed on the View Current Versions
page of Platform Update. To view the SATA drives and their firmware information, use
OpenManage Server Administrator or OpenManage Storage Services.

e The PCle SSD drives and their firmware versions are not displayed on the View Current Versions
page of Platform Update.

e Collect System Inventory On Reboot (CSIOR) must to be run before enum is successful.

iDRACY? - Installation

Prerequisites

Before you update iDRACY firmware using local RACADM or the Dell Update Package, perform the
following procedures. Otherwise, the firmware update operation may fail

1. Install and enable the appropriate IPMI and managed node drivers.
If your system is running a Windows operating system, enable and start the Windows Management
Instrumentation (WMI) service.

3. If you are using iDRACY Enterprise and your system is running SUSE Linux Enterprise Server (version 10)
for Intel EM64T, start the Raw service.

4. Disconnect and unmount Virtual Media.

Installation Instructions

e From the Windows host operating system (managed node), run the Dell Update Package for
Windows and follow the instructions on the update wizard.

e From the Linux host operating system (managed node), run the Dell Update Package for Linux
from the shell prompt. Follow the instructions displayed on the console.

e From the management station, remotely update the firmware using the iDRAC7 Web interface:

1. Extract the firmware image self-extracting file to the management station.

2. Open the IDRACY Web interface using a supported Web browser.

3. Login as administrator.

4. Go to Overview -> iDRAC Settings -> Update and Rollback -> Update. The Firmware Update
page is displayed.

5. Click Browse, select the .d7 firmware image file that you extracted (step 1), or the Dell Update
Package (DUP) for Windows, and click Upload.

6. Wait for the upload to complete. After the upload is completed, the Update Details section displays
the firmware file uploaded to iIDRAC and the status.

7. Select the firmware file and click Install or Install and Reboot. If it is a DUP, Install dynamically
changes to Install and Reboot and at the same time the Install Next Reboot is activated. When
you click Install and Reboot or Install Next Reboot, the message "Updating Job Queue” is
displayed.

8. Click OK The Job Queue page is displayed, where you can view and manage the firmware update.
After the update is completed, iDRACY restarts automatically.

For more information, see the (DRAC User's Guide available at
http://www.dell.com/support/Manuals/us/en/555/Product/integrated-dell-remote-access-
cntrllr-7-v1.50.50.

Upgrade

IDRACY firmware cannot be installed on platforms that support iDRAC6 and cannot be used to upgrade
iDRACS firmware to iDRACY. For more information, see the iDRACY User's Guide available at
http://www.dell.com/support/Manuals/us/en/555/Product/integrated-dell-remote-access-cntrlir-7-
v1.50.50.
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Uninstallation

Use the rollback feature to retumn to the previous installed version of iDRACY firmware.

For more information, see the (DRAC User's Guide available at
http://www.dell.com/support/Manuals/us/en/555/Product/integrated-dell-remote-access-cntrlir-7-
v1.50.50.

Lifecycle Controller 2 Remote Services - Client Tools

Use the WinRM and OpenWSMAN CLI client tools to send WS-MAN commands to Lifecycle Controller.

WinRM

WInRM is a Windows native WS-MAN client. It is recommended to use WinRM 2.0 on Windows
Management Stations. WinRM 2.0 is installed by default as a part of Windows 7 and Windows Server
2008 R2. It can also be installed as a part of the Windows Management Framework Core package on the
following systems:

e Windows Server 2008 SP1
e Windows Server 2008 SP2
e Windows Server 2003 SP2
e Windows Vista SP1

e Windows Vista SP2

e Windows XP SP3

For more information on how to install WinRM 2.0 as a part of the Windows Management Framework
Core package, see article 968929 in the Microsoft Knowledge Base at:

http://go.microsoft.com/fwlink/?Linkld=186253
Recommended WinRM Client Configuration:

e MaxBatchltems = 50

e MaxTimeoutms = 60000

e MaxEnvelopeSizekb = 150

e NetworkDelayms = 60000
Sample WinRM Command (Enumeration Operation):
winrm e cimv2/DCIM_SystemView?__cimnamespace=root/dcim -u:[idrac user]
-p:[idrac password] -r:https://[idrac ip adddress]/wsman -encoding:utf-8
-a:basic -SkipCNcheck -SkipCAcheck -format:Pretty

Note: Lifecycle Controller uses a self-signed certificate for HTTPS (SSL) communication. Self-signed
certificates are not accepted by the WinRM client and WinRM commands do not work without these
options: -SkipCNcheck and —SkipCAcheck

OpenWSMAN CLI

OpenWSMAN CLI is an open source Linux WS-MAN client. OpenWSMAN CLI source code and installation
details are available at:

http://sourceforge.net/projects/openwsman/files/wsmancli

Sample OpenWSMAN CLI Command (Enumeration Operation):

wsman enumerate http://schemas.dmtf.org/wbem/wscim/1/cim-schema/2/DCIM_SystemView -h
(idrac ip adddress) -P 443 -u (idrac user) -p (idrac password) -v -j utf-8 -y basic -R -0
-m 256 -N root/dcim -c cert_name.cer -V
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Note: Lifecycle Controller uses a self-signed certificate for HTTPS (SSL) communication. Self-signed
certificates are not accepted by the OpenWSMAN CLI client and WS-MAN commands do not work
without these options: -c, -v, and -V. See the OpenWSMAN CLI readme for details on these options.

Contacting Dell

Note: If you do not have an active Intermet connection, you can find contact information on your
purchase invoice, packing slip, bill, or Dell product catalog.

Dell provides several online and telephone-based support and service options. Availability varies by
country and product, and some services may not be available in your area. To contact Dell for sales,
technical support, or customer service issues:

1.

2.
3
4

Visit www.dell.com/support.

Select your support category.

Verify your country or region in the Choose a Country/Region drop-down menu at the top of page.
Select the appropriate service or support link based on your need.

Accessing Documents From Dell Support Site

To access the documents from Dell Support site:

1.
2.

5.

Go to dell.com/support/manuals.

In the Tell us about your Dell system section, under No, select Choose from a list of all Dell products
and click Continue.

In the Select your product type section, click Software and Security.

In the Choose your Dell Software section, click the required link from the following:

— Client System Management

—  Enterprise System Management

— Remote Enterprise System Management

—  Serviceability Tools

To view the document, click the required product version.

You can also directly access the documents using the following links:

For Remote Enterprise System Management documents — dell.com/esmmanuals
For Enterprise System Management documents — dell.com/openmanagemanuals
For Serviceability Tools documents — dell.com/serviceabilitytools

For Client System Management documents — dell.com/OMConnectionsClient

For OpenManage Connections Enterprise systems management documents —
dell.com/OMConnectionsEnterpriseSystemsManagement

For OpenManage Connections Client systems management documents —
dell.com/OMConnectionsClient
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